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File Menu

The File menu includes commands that enable you to cache and uncache a cookbook from memory. It 
also contains the command that allows you to print the currently displayed recipe and to exit the program.

For more information, select a command name from the following list

Cache cookbook
Uncache cookbook
Select cookbook
Print current recipe
Exit



A block of memory that acts like a very quick disk file.



Edit menu

The edit menu contains a single option "Copy". This option makes a copy of the currently displayed recipe
and places it on the Windows clipboard from where you can access it from within other Windows 
applications that understand plain text.

The data copied to the clipboard is in a pretty raw format and it is likely that you will have to make some 
manual adjustments to its formatting before using it.



Data on the clipboard can be transferred to other Windows applications



Options menu

The options menu includes commands that enable you to search for a recipe and to change the fonts that
are used to display the recipe.

For more information, select the Options menu command name.

Search for recipe
Text font
Header font



Caching the cookbook

If your computer has large amounts of RAM and a relatively slow hard disk drive then you may find it 
advantageous to load the cookbook into a memory cache. This will have the effect of speeding up recipe 
searches.

Be prepared for a short wait whilst the cookbook is cached when you select this option. The program first 
tries to cache an uncompressed copy of the cookbook. If this should fail due to lack of memory then it will 
try to cache a compressed copy. If this fails then you will be informed that all attempts to cache the 
cookbook failed.



The fastest, most memory hungry cache method



The slower, less memory hungry cache method



Uncaching the cookbook

Uncaching the cookbook releases the memory used by the cache and tells the program to revert to using 
the copy on disk.



Selecting a cookbook

Cookbook manager has been designed in such a way as to allow you to have more than one cookbook 
on disk. You may pick and choose which cookbook you want to perform searches on at any one time by 
selecting its name from the "Select cookbook" sub-menu.

If you have a cookbook cached then selecting a new cookbook will clear the cache, it will also clear any 
recipe list that you may be viewing inside the "Search" dialogue box.

See also:

How cookbooks are managed



Cookbook management

Cookbook manager has been designed to facilitate the easy addition of new cookbooks without the need 
to upgrade the program itself. All you need to do is obtain the new cookbook files and place them in the 
BOOKS directory that can be found in the Cookbook Manager directory.

A cookbook consists of two files. A .DEF and a .DAT file. The .DEF file is a small text file that contains 
essential information, such as the name of the cookbook. The .DAT file is the cookbook itself. Due to the 
somewhat large size of recipe collections, this is a compressed file.

When new recipe collections become available, all you need to do is to place the two files in the BOOKS 
directory. Cookbook Manager will automatically find these files when it is first started up.



Printing the current recipe

The currently displayed recipe may be printed to your attached printer using this option. If you have many 
printers attached to your computer then the default one will be used. Note that this option starts printing 
immediately so you should ensure that your printer is on-line, connected to the computer, loaded with 
paper and ready to print.



Exiting from the Cookbook Manager

When you have finished with the Cookbook Manager you can select this option to quit.



Searching for a recipe

Selecting this menu option brings up a dialogue box that you can use to specify the criteria used to select 
recipes from the currently selected cookbook. For your convenience, the dialogue box is non-modal. This 
means that you can use the main program window without exiting from the dialogue box. Simply click the 
mouse in the program window to use its menus, and back in the dialogue box to use the search and 
display functions.

To learn more about the functions of the dialogue box, select one of these subjects.

Selecting a type of dish
Specifying a recipe filter
Displaying a recipe

When you have defined the type of search that you want, click on the "Search" button to begin the search.
After a short pause the recipes that match the search criteria will be displayed in the "Recipe list" box.

When you have finished using the search dialogue box you may use the Close button to get rid of it. The 
dialogue box remembers all its settings so that the next time you bring it up it will contain all the details 
that you had previously selected.



Selecting a type of recipe

The "Dish type" box contains the options that you can select in order to choose the type of recipe that you
want to search for. You can choose from nine different dish types. In addition to the type of dish you can 
also choose whether you want to see meat dishes, vegetarian dishes or both. Simply select the 
appropriate check box(es).



Specifying a recipe filter

In addition to being able to specify the type of recipe that you want to see, you can also look for recipes 
that contain keywords of your choice.

If you want to list all those recipes matching the selected dish type then you should select the "list all" 
button. If, however, you want to list only those recipes that contain a certain keyword then you should 
select the "filtered" button and enter the keyword that interests you in the adjacent box.

If you are using the "filtered" option then you should select either one or both of the "Recipe description" 
and "Ingredients" buttons. These buttons tell the program where abouts in the recipe it should look for the 
keyword.

The "Recipe description" is the short paragraph that occurs just before the list of ingredients. It usually 
contains a short description of the recipe, where it came from etc.

The "Ingredients" part of the recipe is the section that starts with the "Ingredients" header and ends with 
the "Procedure" header.



Displaying a recipe

When you have completed a recipe search and want to display a recipe in the main program window, first 
select it from the "Recipe list" box. Click on the "Show" button, and, after a short pause the recipe will be 
displayed in the main program window. An alternative to the "Show" button is to double-click on the name 
of the recipe in the list box.

Notice that the dialogue box does not go away when you click on the "Show" button. This is to allow you 
to select and display other recipes at your leisure. When you are finally done with the dialogue box you 
can use the "Close" button to dismiss it.



Selecting a text font

The text font is the font used for displaying the body text of the recipe. The program remembers the font 
that you select when you quit so that it is the same the next time you use the program.

See "Using the font dialogue box" for further information.

Using the font dialogue box



Selecting a header font

The header font is used to display titles within the recipe. The program remembers the font that you select
when you quit so that it is the same the next time you use the program.

See "Using the font dialogue box" for further information.

Using the font dialogue box



Using the font dialogue box

The font dialogue box may seem familiar to you, and so it should. It is the self-same dialogue box that is 
used in the standard Windows applications such as Write.

The font, style, size (in points) and effects can be selected using the normal dialogue box controls. In 
addition to these font styles you can also choose the colour of the text by clicking on the "Color" button 
and selecting from the drop-down list.

The same font will be used for both the on-screen recipe and for any printed copies that you make. For 
best results you are advised to use only TrueType fonts.



1 point = 1 / 72 of an inch



Copyrights

The program that you are using was written by Andy Brown in July 1993. You may freely distribute this 
program provided that it remains intact and that no more than a handling charge is made for it. You must 
be clear in that any charge that you make is for the Windows program, and this help text alone. No charge
must be made for the accompanying Usenet Cookbook recipes database, as that is covered by the 
following copyright. This is an extract from the "Introduction" file that accompanies the Usenet cookbook.

Copyright (c) 1993 Usenet Community Trust

Permission to copy without fee all or part of this material is granted provided that the copies are not made 
or distributed for direct commercial advantage, the Usenet copyright notice, title, and publication date 
appear, and notice is given that copying is by permission of the Usenet Community Trust.



Usenet, and the cookbook

Introduction

This is a community cookbook, from an invisible worldwide electronic community. Like all community 
cookbooks, it has the favourite recipes of the members of the community, suitably edited and organised. 
The "Usenet Cookbook" is a collection of the favourite recipes of Usenet readers worldwide.

Usenet

Usenet is the network by which Unix computer users talk to each other. It is a worldwide net, made from 
computer-to-computer telephone links, linking some 500,000 people at 7,000 sites in 30 countries. 
Besides serving an obvious technical and scientific purpose, Usenet is also a medium for linking 
worldwide social groups of people who share common interests. As an experiment in interactive 
publication, some members of Usenet decided in 1985 to make a cookbook of favourites from their 
"global village". Brian Reid of DEC Western Research in Palo Alto, California, organised the venture and 
wrote much of the requisite software. The Usenet Cookbook is an on-line database distributed with the 
intention that it be published as a book. The Usenet Cookbook is distributed with software that enables 
every user to make his own customized edition of it, leaving out the recipes that he has no interest in, and
perhaps adding a few of his own that he hasn't yet submitted to the network. There will be many different 
versions and editions of it, all with the same title, and all copyrighted. Every    user can choose whether to 
print the recipes in imperial units (cups and spoons) or in metric units (this edition of the Cookbook, since 
it is European in origin, uses metric units).

The Author

If you like this program, hate it or would just like to talk to me then I can be contacted at

28 Ashburn Drive
Wetherby
West Yorkshire
LS22 5RD
ENGLAND (UK)



Clicking the left button twice in rapid succession



Menu keyboard shortcuts

"Ctrl" means that you should hold down the Control key and press the associated letter.

Ctrl+C Cache cookbook
Ctrl+U Uncache cookbook
Ctrl+P Print current recipe

Ctrl+Ins Copy current recipe to the clipboard

Ctrl+S Search for recipe
Ctrl+T Text font
Ctrl+H Header font



Recipe keyboard shortcuts

Cursor-up Move up    1/4 of a page
Cursor-down Move down 1/4 of a page
Page-up Move one page up
Page-down Move one page down
Home Go to the top of the recipe
End Go to the bottom of the recipe



Updates since the first version

Version 1.10beta

Printing multi-pages now works. You now need at least Windows 3.1 to run the program

"Copy" option added to the "Edit" menu (due to popular demand)

Searching for keywords in the ingredients now works. (A one character typo in the source caused this 
one.)

Added a "Meat" button to the "Search" dialogue box. This means you can now search for meat, 
vegetarian or both types of dish.

Custom font and colour dialogue boxes were scrapped in favour of the common dialogue versions that 
come with Windows 3.1

The Help button in the Search dialogue box works (as it always should have done !)

Complete rework in order to break the program away from just the Usenet Cookbook and allow new 
cookbooks to be added by me at a later date. There is as yet no facility for people to add their own recipe 
books. It requires a bit of technical knowledge and access to a Unix system (such as Linux). I may 
simplify the procedure in a future version, it depends on feedback from users.

Bug that caused font sizes to be incorrectly calculated has been fixed. Yes, I admit to my bugs !

Version 1.10

You may now create your own cookbooks using the MAKEBOOK.EXE utility. See the README.TXT file, 
located in the MAKEBOOK directory for full directions.



How to get the best performance

I developed this program on my PC which is a 486-33 with 4Mb RAM and a 9ms HDD backed up by a 
1Mb caching controller. As you can imagine this is a pretty fast setup. As soon as I released it for testing 
to one of my friends (yes Gavin, you !) with a more modest 386SX-25 he immediately complained about 
the speed, or lack of it.

Searching the recipe book is both processor and disk intensive. The best advice that I can give is to use 
all the caches that you have got. Microsoft Smartdrive will greatly speed up disk access, especially if your 
hard disk is slow. Processor caches such as that built in to the i486 and the external caches found on 
motherboards will make the decompression fly along. If you have a lot of RAM then it will be 
advantageous to use the "Cache cookbook" option.



About the Linux operating system

Linux is a free, Posix compliant, multi-user Unix-clone operating system for 80386 and above computers. 
It is a complete Unix, with TCP/IP, X-Windows and everything else you could wish for. In my opinion it is 
the most powerful operating system that you could possibly lay your hands on. What's more, it's free.

Linux was written by Linus Torvalds and is available from nic.funet.fi, tsx-11.mit.edu, sunsite.unc.edu 
and the multitude of sites that mirror these places. For more information you should follow comp.os.linux
for a while. Failing that, try fingering torvalds@klaava.helsinki.fi.

Without Linux I could not have written this program, or the many others that I work on which require the 
power of the Unix tools. Support free software.



Unix is a trademark of AT&T



A network transparent windowing system



A network communications protocol




